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PROMET@Work minimum installation requirements

o  Microsoft Visio® 2003

e Microsoft .NET Framework Version 1.1 Redistributable Package
(Download link: http://www.microsoft.com/downloads/)
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1 Introduction

PROMET@Work is the user-friendly process modeling environment for the PROMET-Method. The
PROMET-Method was developed by the IMG AG. PROMET@Work is based on SemTalk. Because
Microsoft Visio is embedded in SemTalk it combines the graphical strength of Microsoft Visio and the
consistency of a professional modeling tool.

The main purpose of this tutorial is to learn how to model business processes with PROMET@Work and
provide reference material for process modeling problems. This tutorial will explain the most important
PROMET@Work functions.

A practical example will be used to address specific modeling issues, but for more in-depth explanations the
reader will be asked to consult the corresponding IMG publications available at www.img.com. Furthermore,
it is assumed that the reader is familiar with the basic Microsoft Visio® functionalities.

Note:

PROMET@Work start language will be set according to your system settings. To change your regional
settings and system language please go to START>Settings ?System control >Regional and language
options.

Formatierung / Symbol Erldauterungen
Menu items Menu and context menu items in text are always written in
bold-italic.
Menu item-> submenu item Multiple menu items in a menu path are combined with
arrows.
||~ tutorial example The green arrow marks a tutorial example to build up a full

tutorial model.

The movie button denote a Link to a video chapter of our
online video tutorial. The video chapter shows the described
[:::] functionality of chapter on the basis of tutorial example. To
watch the videos in internet browser you need an internet
connection and an installed flash player.

) The star labels a note for important additional information of
hint current context.

© SEMTATION / The Information Management Group 1
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2  Getting Started SX®

Start PROMET@Work using it’s icon on the desktop or select Start->Programs-> PROMET@work and
begin to work.

&

After doing this, you will see the default modeling environment, which consists of the “PROMET@Work”
explorer (1), which displays diagrams, objects, relationships, methods, attributes and data types, the drawing
window for modeling(2), the corresponding shape stencil (3) with predefined symbols for process modeling
and the zoom and navigation window (4):

M= Document - PROMET@work

File  Object Diagram  Visio  Simulstion  Tools  Help

NSEHAAATERD v+ L0 B 0@ S0

semTalk o x
& [ Model

(=27 Diagrams

| @ [ Aufgaberkette

-4 Objects

MG ks

A COMPANY OF S&T

apes
e os
ch here
) ufgabenkatte |
~
[ Jeuipbe O engng O ausgong

Nt [E Fsotra 5 b

@smm ? seichenin @D st

@ AND @ CR @ HOR

> Entscheid.., ) oﬁ-vage...Dc mmmmm !
@5 ggggg o o292 @ Breskpoint

¥ M 4 » M| Aufgabenkette-1 JE i I »

Figure 1: Modeling environment

Process relevant diagrams and objects are displayed as a tree structure in the PROMET@Work explorer.
You can hide or show the explorer using the icon &b or selecting from the menu options Extras >Explorer.

A new document will contain an empty “activity chain diagram” page. Before starting to model you may also
want to add a background to your page(s). If this is the case go to the menu option Tools>SemTalk
Options >Extras (Tab) and select the option Show Background Pages. Edit the background page by e.g.
placing in your company logo. You may also insert automatic page numbers and text fields by selecting from
the menu option Visio2>Drawing > Text and using its context menu (mouse right click).

© SEMTATION /The Information Management Group
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3 Process modeling with PROMET@Work

Modeling is not a science. Modeling is an art and thus, two models of the exact same process done by
different people will always look different. Modeling notations and the consistency check in PROMET@work
aim at minimizing the differences that could arise from the understanding of a process by different people.

Likewise, modelers use different techniques to model a process. Some people model follow a “top - down”
approach, i.e. from an abstract (coarse) representation to a more detailed (refined) description of a process.
On the other hand, just the opposite “bottom - up” seems to be very comfortable to some people.

Therefore, this tutorial covers both modeling approaches using the same example. Section 3.3 explains a
process modeling starting with an activity chain and connecting it with higher level process models. Section
3.1 begins with a process map (most abstract process description in the PROMET method) and continues
straight forward to an activity chain model. If you want to follow a “top - down approach” skip section 3.1, but
if you want to begin with an activity chain begin with 3.1 and continue until section 3.2.5.

© SEMTATION /The Information Management Group 3
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3.1 Diagram Types in PROMET@work

The PROMET method has different predefined diagram types for specific purposes. The following table
explains briefly the purpose of each diagram type:

Table 1: PROMET Method Diagram types

Diagram aim Diagram type Description

process map A process map shows the top level processes of the
interacting business partners. For each business partner the
most important output flows are specified between the top
level (or macro) processes.

process context A process map context shows the outputs and output flows
for one specific process.

Process description in
different refinement

levels process A macro process is decomposed into several micro
decomposition processes. Output flows can connect micro processes of
different business partners.
activity chain Activity chains are used to describe macro and micro
processes at a finer grained level. Swim lanes represent
human resources executing activities.
(Hierarchical) human | organizational In the organizational chart you can define organization units
resources description | chart of the business partners.
Information object output model An output model is a class model which uses UML Notation
interaction description to define in an object oriented way the outputs or services of

processes and activities.

The PROMET methodology is quite robust at modeling value chains between business partners as
enterprises, customers and suppliers. Business processes are modeled on three well defined levels of
abstraction: macro process, micro process and activity.

To create a new diagram of any of the above listed diagram types select from the menu options
Diagram->New > ....

= Yisio  Tools  Help

process map
S0 Edit process context

i

i x Delete process decomposition

activity chain
7 Insert (Madel) ¥

I
4 Golp
#] Refresh

output model

organization chart

|
Figure 2: PROMET Diagram types
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3.2 Bottom - Up Process Modeling

In the PROMET method the most detailed process diagrams are the “activity chains”. Activity chains are
used to describe macro and micro processes at a finer grained level. The simplest way to create a new
activity chain is to select from the menu options Diagram->New->activity chain. If you have already
created one or more activity chains you may just right-click on “activity chain” in the explorer and select
“New”. Click on the diagram names in the explorer to jump directly to existing diagrams or select “Delete”
from the context menu to remove the chosen diagram.

PROMET@Work creates a new diagram of type “activity chain” with its corresponding stencil.

[F Activity Chain b

.3
) S InFarrnation uses
O epom O ewom N G v 7 e

(?3 stake ta (?D read frorn @ AMD @ OR @ XOR <> Dracizion O Of-Page...
Cornrment 6Sewice {—brﬁlﬁsage @ Breakpoint - v breaks

Figure 3: Activity chain shapes

3.2.1 My first activity chain C]

As the name suggests it, activity chains contain activities encapsulated as a process. These activities are
performed within an organizational unit by persons or machines. PROMET@Work uses Visio’s functional
bands (for the purpose of this tutorial we will call them ‘swimlanes’) to represent the performers of an activity.

To use \Visio’'s functional bands please select from the menu bar the option

Visio >View >Swimlanes >vertical or click on their icon B from the toolbar. Next enter the number of
swimlanes for this activity chain diagram. Remember that the swimlanes represent organization units
(company, role or person). You may add or delete swimlanes afterwards. You can name the page (e.g.
Online delivery) and the swimlanes title bar will replicate the name.

To assign a swimlane to an organization unit you may just write its name on the header box of the swimlane
or select from the swimlane’s context menu the option Select Resource.

© SEMTATION /The Information Management Group 5
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ﬂ' Document - PROMET@awork

File  ©bject  Diagram Wisio  Simulation  Tools  Help

INSHIAARATERD ¥+ 4L/ FE0@IDHE S W%

|7 English

actifity chain-5

Functional i Functional Functional
band.2769 band.2768 band.2770

ﬂ' organisation unit

Fielatian | uses hum resource 3

[ Ok J[ New }[ Eancal}

Figure 4: Assigning an organization unit to a swimlane

As shown in the figure above there are no organization units in the model. If this is your case, click on the
“New” button to create a new unit. In this example we will name them “Joe Doe”, “Customer Service” and

“Shipping”.

© SEMTATION /The Information Management Group
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ﬂ' organisation unit: Joe Doe

General |Language Members | Measures | Off-time | Audit

Mame |.Joe Dioe |
Mamespace: | 3z |
Class: customer v Mew

Comment; &
department 0 >

department co
department cu
department su
td anager
organisation unit
Perzon b

Links:

[ Read Only

[ Ok H Cancel ]

Figure 5: Select class of organization unit

To this point we have only created the organization units, but we have not specified if they represent a
company, a role, or a person. Therefore, open the edit dialog of the swimlane (e.g. Joe Doe) and change its
class to customer, as shown in the figure to the right.

As you notice the color of the swim -lane’s header in blue now, indicating that “Joe Doe” is the customer.

Repeat this procedure twice and assign “Customer Service” and “Shipping” to the other two swimlanes (they
are part of the company).

The result should look like the figure below:
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* TutorialExample3.0_eng.vsd - PROMET@work

Ele  Object Diagram  Visio  Simulation  Tools  Help

PEHIaTEX il e s E0@E RS g )

SemTalk 0O x
= [ Model
=11 Diagrams
= [ activity chain
= [ activity chaire1 [1 acti!ty chain-1

© | shipping
©  Joe Doe Customer service shipping
© | Customer service

|

wooz R uey

B

#-{_4 Objects

Shapes [mi4

Search for Shapes:
Type your search here -

[ Activity Chain |

r:lacu\tity O Enrpoint O ExitPoine

oo [ oses.. £ o,
@Buﬁer ? stare ta @) read frarm
@ AND @ oR @ HOR
<:> Decsion L) OffPage... DComment
@Samlce O—bg‘oﬁ“ge @ Breskpoint

wooom breaks

Seite 1von 1

£

| 4 4 » M activity chain-1 J< 2

Figure 6: PROMET@Work swimlanes in activity chain diagram

Now you are ready to insert activities into the diagram. Activities are the basic elements in a business
process model in PROMET@Work. Like said before, the swimlanes represent organization units. Corres-
ponding activities are placed on the swimlanes meaning that the organization unit will be responsible or will
execute that activity.

Please drag the activity shape from of the stencil onto a swimlane. The activity has temporarily the name
“activity.xxx” You can select an activity shape and write directly its name on the shape. The activity will
accept this name, but this was not done according to an object-oriented approach.

To follow the object-oriented approach select an activity shape and choose from its context menu the option
Compose. You will see the following dialog immediately afterwards:

© SEMTATION /The Information Management Group
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o= New Ob ject
Root Class autput "
Clazs: arder "
(3 Adtribute O State
w Al
kethod: receve w All
Ok, §|’ Cancel ]

Figure 7: Compose dialog

In the Compose dialog you can compose the activity name from outputs and their methods, attributes or
states. The following is a brief description of each control:

Rootclass is the basis class of the object in the name of the activity. In PROMET@Work it is always
“output”

¢ Class is an already existing output or new output.
e Method is an already existing method or a new method of the class. The verbs of the class.

¢ Attributes or States can only be used in combination with a class and a method. An Example could be
“check Concert Ticket Date” where “Date” is an attribute of “Concert Ticket”.

Button “All”: After clicking it all methods in model existing are listed in the “Method” combo box.

Methods, Attributes and States are inherited from superclasses. Because “send” is a method of Product and
Concert Ticket is Ticket and Ticket is a product, you can “send” a Concert Ticket.

Class: Concert Ticket + Method: send = Activity: send Concert Ticket

You can always rename activities by just repeating the procedure before described, but you can also open
the activity’s Edit dialog and replace the activity with a new one by typing a new activity name in the textbox
name.

© SEMTATION /The Information Management Group 9
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= activity: process onder.2 D@@

General | Language | Hum. Resource | Condition | Meazures | Audit

M arne

L
Irdes: a

Caomment: Language | Englizh w
Linksz:

[] Read Onby

I ok, H Eancel]

Figure 8: Activity — Edit dialog

Next, you can connect the activities in the appropriate sequence using now the Information flow connector.
Activity chains show the information flows between activities. Drag an “Information flow” connector on the
background and then move each of the end points on a connection point of one of the activities. A small red
box on top of the connection point will indicate that connector was coupled appropriately. The “connector

tool” n}-n becomes very handy when connecting many objects together. Select the e.g. the information flow
shape from the stencil (do not drag it) and them click the “connector tool” and while holding down the mouse
button select two connection points of the objects you want to associate.

To allow the connector to move around the shape, position the “connector tool” over the centre of the first
shape until a red box appears around the shape. Hold down the mouse button and drag to the centre of the
second shape. When a red box appears around the second shape, release the mouse button. This is called
a shape-to-shape connection.

You may also connect multiple shapes (more than two) at once. In order to do this select shapes in the order
you want them to be connected. Click on the corresponding connector icon on the stencil (in this case
information flow) and from the menu options select Visio >Shapes->Connect.

In order to specify the actual information (output) that flows through the information flow use the “Edit” menu
and right-click on the connector. On the tab “object flow” you can specify the output objects. Enter the name
of the output in the combo box labeled “Class” and add it to the list of outputs clicking the “Add” button. You
may also choose one of the before created outputs from the combo box. A graphical representation of the
outputs can be done in an output model (output diagram, see section 3.4).

© SEMTATION /The Information Management Group 10
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ﬂ' information flow: information flow. 284 2

General | Obiject Flow | Meazures | Audit
Rioot Class | outpul o
Clazs: | "
iFaice
@ offline invnice
onling invaoice
order
D ot [payment
zhipping order
hicket request
Add
[ ok l[ Cancel l

Figure 9: Output tab in output flow dialog

Complete the activity chain according to the information in following table:

Index - Information/output
number: Gl e (Information flol\)lv)
1 receive Order
Order
2 process Order
Order
3 generate Invoice
Invoice
4 send Invoice offline
Invoice
6 receive Invoice offline
Invoice
5 send Invoice online
Invoice
7 receive Invoice online
8 receive Payment
Order approval
9 generate Shipping order
Shipping order
10 process Shipping order

© SEMTATION /The Information Management Group 11
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Rename the activity chain to “Sales” by editing the diagram name on edit dialog via context menu
of diagram and it should look like this:

ﬂ' TutorialExample3.0_eng.vsd - PROMET@work

File  Object  Diagram Wisio  Simulation  Tools  Help

NSHS ARATEHEXD++ L5 0 FEn@TH S » English 2|

Sales

_- Customer service shipping

receive order.1

order

process order.2

order

receive offline g send offline ’ ’
invoice.5 [¢—invoice— invoice.d l—invoice generate invoice.3
receive online Jo send online .
invaice.7 +—invoice invoice.6 involce:

generate shipping
order.9

process shipping

receive payment.8 (—order approval-e| order.10

—tshipping order—e

4 4 b M| sales - 12 I

Figure 10: Activity chain diagram

If you are familiarized with the PROMET method, you must be asking yourself “where are the entry and exit
points in this model?” Entry and exit points are well defined interfaces. Between every two of those elements
information and resources are consumed and transformed within activities and information flows by means of
“‘information flow” associations.

You may add entry and exit points to this model using the corresponding
shapes in the activity chain stencil. But since we want to exercise the
PROMET method, we will create automatically these interfaces later out
of a higher level model in PROMET.

After completing sections 3.3.1 to 3.3.5 select the micro process “Sales” o
and select its context menu item “activity chain”. At this moment you Remove
should be able to see the entry and exit points in your activity chain

model. Please connect these interface points with the corresponding DL
activities. Expand

Music
Inwoice

"—‘ %  activity chain

] Detach

Your model should look now like this:
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Figure 11: Finished activity chain diagram
See sections 3.6 and 3.7 for more information on adding physical resources and buffers to activity chains
respectively.
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3.3 Top - Down Process Modeling

In the PROMET method the most abstract process modeling level is the “process map”. The simplest way to
create a new process map is to select from the menu options Diagram->New-2>process map or if you
already have created one or more process maps you may just right-click on “process map” in the explorer
and select “New”. Click on the diagram names in the explorer to jump directly to existing diagrams or select
“Delete” from the context menu to remove the chosen diagram.

3.3.1 Creating Business Partners

PROMET@Work opens the stencil associated to the diagram type:

[F process map
5?&25 @3 output Ao Comrment

Figure 12: Process map shapes

||| P

Analogously to section 3.2.1 swimlanes are used in process maps to illustrate organization units, but mainly
business partners. Please add three new swimlanes to the process map.

[\ TutorialExample3.0_eng.vsd - PROMET@work

File  Object Disgram  Yisio  Simulation  Tools  Help

NG AATHRXI el rE0@TQH S 0% = Engiish &
semTalk O x E ~
= (27 Model process map-4 =
I=.% Diagrams ]
- activity chain . g
-2 process map Music inc. Intertainment.co
= [ process map-4 ]
© Joe Do
© Musicinc.
@ Intertainment o x
-] Objects
& |

Shapes

Search for Shapes:
Type your search here p

[H process map
macro 2,
process @)outputﬁow
3 8
¥ |4 4 b M| sales | process map-4 Jf_ | >

Figure 13: Process map with business partners
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Give each of the swimlanes a name for a business partner by selecting first the shape in the drawing pane
and then just write over it the name. For the example we will name them “Music Inc.”, “Intertainment.com®
and “Joe Doe” respectively. Please change the class for each business partner to “supplier”, “company” and
“customer” respectively. (If you went through section 3.2.1 you will notice that the swimlane “Joe Doe” takes
automatically the right color.)

You can edit the objects selecting one of them from the drawing pane or from the explorer and selecting from
the context menu (right-click) Edit. You can also use the menu option Object->Edit or just double-clicking
on the object.

3.3.2 Editing Objects C]

Using the “General Tab” of the edit dialog you can change the name of objects. You may also add comments
or (hyper-) links to attached documents and document templates.

ﬂ'supplier: Music inc.

General | Language | Members | Measures | Off-time | Audit

Mame Mugic inc.

Mamespace: "

Class: supplier hd New
Comment; Language | English “
Lirkz:

[] Read Only

I OE. H Cancel ]

Figure 14: Edit dialog - General Tab (e.g. supplier)

If a MS Office document template has been attached as (hyper-) link to this object you may double click on
this link and create a new MS Office document based on the template. Once you are done editing the new
document a new link to it will be added to the list of links automatically.

One of the major differences between PROMET@Work and plain MS Visio is that the same object e.g.
a business partner can be displayed in multiple diagrams (pages). Each Visio shape for this business
partner is just a representation of the same object. If you modify the object in one diagram and the same
object is used somewhere else, you will modify it everywhere. This is the reason why you cannot create
a different business partner named “Intertainment.com“. To insert an object in different pages please
select the option Insert from the context menu of a page (right-click on the background).
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Please note the difference between PROMET@Work’s menu option “Remove” and MS Visio’s
Delete (or the “Del” key). The context menu option “Remove” erases an object from the
database (Explorer) and from every diagram and cannot be restored. There is no undo for this
option. MS Visio’s “Delete” only deletes the selected object from the current diagram.
You can restore it using the menu option “Undo” &7

3.3.3 Creating Macro Processes and Output Flows

In order to create macro processes drag the macro process symbols form the process map stencil onto the
business partners. Please notice that after dropping a macro process shape in a swimlane it adopts the color
of the swimlane. You can only drag the “color matching” shapes on the business partners.

Each business partner shape is a MS Visio group shape. If you move or remove such an object all elements
contained in that group will be moved or removed.

Please insert five macro processes in your process map as shown in the figure below.

[\ o TuterialExample3.0_eng.vsd - PROMET@work IZ”E”E'
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— 1 Music prc
1 Musik on

wooz g ued

¢ 2 Concert t Music production.1 Musik on demand.1
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o 2Atend oo,
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Concert ticket sales.2
[ process map ‘

-~
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Rl I I DI[ Sales J process map-4 J( | >

Macro Process: Mmacro process, 2911

Figure 15: Macro processes in a process map

The next step is to add the output flows. The process map level displays only the most important output
flows between business partners. Drag an “output flow” connector on the background and then move each of
the end points on a connection point of one of the macro processes. A small red box on top of the

connection point will indicate that connector was coupled appropriately. The “connector tool” s becomes
very handy when connecting many objects together. Select the e.g. the output flow shape from the stencil
(do not drag it) and them click the “connector tool” and while holding down the mouse button select two
connection points of the objects you want to associate.
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To allow the connector to move around the shape, position the “connector tool” over the centre of the first
shape until a red box appears around the shape. Hold down the mouse button and drag to the centre of the
second shape. When a red box appears around the second shape, release the mouse button. This is called
a shape-to-shape connection.

You may also connect multiple shapes (more than two) at once. In order to do this, select shapes in the
order you want them to be connected. Click on the corresponding connector icon on the stencil (in this case
output flow) and from the menu options select Visio>Shapes >Connect.

on.1 = Musii

Figure 16: Correctly connected objects

In order to specify the actual output that flows through the output flow use the “Edit” menu and right-click on
the connector. On the tab “object flow” you can specify the output objects. Enter the name of the output in
the combo box labeled “Class” and add it to the list of outputs clicking the “Add” button. You may also
choose one of the before created outputs from the combo box. A graphical representation of the outputs can
be done in an output model (output diagram).

[\ o output flow: output flow.423

General | Object Flow | Measures | Audit
Footclass: autput “

Clags: Tickets v

(%) State O Attribute
[~ NOT LY

Add

A

Figure 17: Output tab in output flow dialog

The completed process map should look now like this one:
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Figure 18: Complete process map

You can create several process maps. A new process map is created by right click on the browser entry
process map>New and from the menu option Diagram >New >process map.

If you need to display the same business partners in multiple process maps you must insert a business
partner into the other diagram. You may also use copy & paste.

o0
3.3.4 Creating a Process Context T

A process context diagram focuses on one macro process from a process map. This diagram type intends to
display all of the output flows of one macro process to other macro processes in the same or different
business partners.

In the example we want to show now the process context of “Music On Demand”. Right click on the macro
process “Music on Demand” and select the context menu option process context.

PROMET@Work creates a new process context diagram for “Music On Demand”. It automatically
inserts a new view of the original business partners and the macro processes.
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Browse
5 Expand
| # process context
¥ | activity chain
¥ process map
Detach

Figure 19: Process context option

Once you have created the process context diagram right click again on the menu you can navigate from the
process map to the process context.
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Figure 20: New process context diagram

Another way to create a process map is to select from the menu option Diagram >New -?process context.

Please note that different Visio stencil(s) open depending on the type of the diagram. Every stencil contains
shapes for the current diagram type.

In a process context diagram you should only create new output flows on the macro processes already
defined in the process map.
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With right-Click “Insert” on the background of the page you can insert existing business partners into the
process context diagram.

ﬂ' Insert ['ZITEIEI

Obijekt Filk
Ik TRt [ Existing

[ Invisible [ Metamodel l External l [ Index ]

Attend concert [mal)
Concert ticket zales [ma)
Cuztomer Service
Shipping

Al b aster
W Imzert all valid B elations () Default (ML (%) Shape
[+ Create Location

Ok l [ Cancel l

Figure 21: Insert dialog

The objects “Intertainment.com”, “Music Inc” and “John Doe” are shown now in the browser as children
nodes of both diagrams.

If you rename a business process in one diagram (e.g. John Doe to John Doolittle), it will be renamed in
every diagram where it exists.

Additional macro processes can be displayed within their corresponding business partners by right-clicking
on the business partner and selecting the context menu option Expand. Select an object from the list.
“executes” indicates that the business partner object is associated to a macro process through the relation
“executes”.
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Figure 22: Expand dialog

Please select “Concert Ticket Sales” from the list and press OK.

Now you can add new output flows to the macro processes which might have been too many details in a

process map.

Select Find from the context menu of a page or from the menu button option to search for existing

objects by name in your model.

Select Browse from the context menu of an object to navigate to other places in your model where

these object exists.

If you accidentally deleted a connector (e.g. output flow you can restore it using Expand from the

context menu of an object.

3.3.5 Creating a Process Decomposition

A process decomposition shows the internal structure of a macro process by means of micro processes and
its output flows to micro processes of other macro processes.

Select “Music On Demand” on the process context diagram and select from the context menu process

decomposition.
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Figure 23: Swimlanes in a process decomposition diagram

As you have probably already noticed, a pop-up window requests the confirmation of the name for the name
new diagram. The first letters identify the diagram type and it is only for your convenience, but you may
change the name as you wish.

Similar to what happen when a process context diagram was created you can now insert other relevant
business partners here. Additionally, you can close swimlanes to a macro process shape (which still contains
the corresponding micro processes) and vice versa open macro processes to a swimlane shape. Use the
option To Group from the context menu to go from macro process shape to swimlane shape and No Group
to do the same the other way around.

You can add now micro processes to the macro processes “Music On Demand” and “Listening to Music”.
Use the shape “micro process” to create micro processes within “Music on Demand” and “Listen to Music” as
shown in the figure below.

Use output flows to connect micro processes. The output flows may connect micro processes within a
business partner or between two business partners.

Your process decomposition diagram should look like this:
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Figure 24: Process decomposition diagram

Outputs flowing between micro processes should match the outputs specified for their macro processes. This
is why in the class combo box of the output tab you will see only those outputs that where defined for the
corresponding macro processes (e.g. on the output flow between “Offline Delivery” and “Sales” is restricted
to “Order” and “Payment” and thus “Music” is not in the list). This list is just a recommendation. You may
enter in the combo box whatever output you consider appropriate and include it in your list of outputs.

3.3.6 Creating an Activity Chain QL

Once again there are multiple ways how to create an activity chain. The simplest way is select from the
menu option Diagram ->New >activity chain.

PROMET@Work creates a new diagram of type “Activity Chain” with its corresponding stencil. As you notice
PROMET@Work asks with a dialog if you want to insert automatically the swimlanes you used in the original
micro process decomposition. If you choose OK you may delete those swimlanes that you do not need in the
activity chain or you may add new ones. If you press Cancel no swimlanes are generated, but you may insert
the existing ones or add new ones.
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To add swimlanes please select from the menu bar the option Visio >View-2>Swimlanes->vertical or their
icon from the toolbar. Remember that the swimlanes represent organization units (company, role or person).
You may add or delete swimlanes afterwards. You can name the page (e.g. Online delivery) and the
swimlanes title bar will replicate the name.

To assign a swimlane to an organization unit select from the context menu of a swimlane the option Select
Resource. (See section 3.5 for more information about modeling organization units).

Usually you will create an activity chain for a micro process or a macro process. In order to maintain the
consistency, find the micro or macro process you wish further to detail. From its context menu select activity
chain. As you can see PROMET@Work generates automatically the entry and exit points for the activity
chain. The basis micro or macro process shape has its name underlined denoting that it has a refinement
(i.e. the activity chain).

Please create an activity chain for the micro process “Sales.1.1”. You may insert now the corresponding
swimlanes. To do this select from the page context menu the option Insert. Please add Joe Doe, Customer
Service and Shipping. (To continue with activity chains go to section 3.2.1 now.)

The activity chain should look like this:
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Figure 25: Activity chain diagram
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3.4 Creating an Output Model CJ

An output model is an object-oriented class model. PROMET@Work recommends the use of the UML
notation for output models in business processes. Therefore, an output model is a representation of classes
with specializations (subclasses) and associations.

The main idea of an output model is to define a common language understanding between business
partners. Output models can be exported to CASE Tools and the Semantic Web languages like OWL. These
models are compatible with other SemTalk 2 components and PROMET@Work models.

A more detailed description about creating and sharing of class models can be found in the general SemTalk
tutorial.

To create a new output model select from the menu option Diagram->New >output model.
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Figure 26: Output model
Specializations (subclassOf) are used in the output flows of micro and macro processes. If you are using
“Ticket” on the macro level, “Concert Ticket” will be offered as an output option on the micro process level.

Following an object-oriented approach you can define attributes, associations and methods to outputs. A
class will inherit these properties to its subclasses, but you can also define further specific properties to the
subclasses.

Please use in the Edit dialog of an object the “Attributes” and “Methods” tab to edit these properties.
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Figure 27: Editing output methods and attributes

In general, object-oriented modeling of outputs improves transparency in the model, but PROMET@Work
recommends it especially for creating reusable process modules. Section 3.2.1 explains how to create
activities based on the object-oriented output model.

3.5 Creating Organization Charts C]

Further on in this tutorial we will see how organization units are assigned to tasks (in Activity Chain models),
but before we must define those organization units for the involved business partners.

Create a new organization chart by selecting from the menu option Diagram->New->organization chart or
right clicking on the node organization chart in explorer and select the New.

In the new diagram you can now insert the business partners by selecting from the page context menu the
option Insert. You can also add new organization units using the shapes on the “orgChart” stencil. Both
shapes “department2” and “department3” represent organizational units where you define their manager and
members. The only difference between them is that in one you visualize the org unit name, manager name
and members name and in the other one on the org unit and manager or members names.

Insert the business partners and organizational units from your process model in an organizational chart.
Use the connector “superiorof” to connect “Intertainment.com” shape with these two new objects. This
diagram should like this:
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Figure 28: Organization chart

On the left side of the tab you see a list of the already assigned persons and/or managers to this
organization unit. The combo box directly on top of it shows the relation serving as a filter for the persons
you see in the left list box. The right list shows all the managers or person available for a organization unit.
The combo box on top of it serves as a filter for the right list box. For example, if you want to assign a new
manager to a unit change first the right combo box to “Manager” and select or create a person as a manager
(with the New button). It will automatically land in the left list. You may move persons between lists using the

buttons (<, >, >>) between the lists.
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Figure 29: Organization unit dialog — Members tab

If you double click on the name of a person you can edit supplementary attributes of that person.
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Figure 30: Person dialog — Details tab
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Furthermore, you can specify business process variables for an organization unit, position (role) and/or a
person in the “Measures” tab.

ﬂ' Manager: manager1 El[ﬁ@
General | Language Details| Measures | Off-time | Audit

Fived Cost: 1000 |
Variable Cost: 300 |
Capacity: |'I - |
Strateqy:

Setup Time: |D |

oK | [ Cancel ]

Figure 31: Organization dialog — Measures tab

3.6 Physical Resources

Usually activities need not only human resources to be carried out, but also physical resources (e.g. a
computer, a table, a printer, a telephone, etc.) The activity can only be executed if enough capacity of the
resource is available.

With PROMET@Work it is possible to assign resource to activities in the activity chain. You may use the
PROMET@Work stencil’s general shape for physical resources or one of the MS Visio shapes. To open a
MS Visio stencil select from the menu bar the option File->Open Stencil and choose a stencil from the list
shown to you.

Please open the stencil called “Computers and monitors”. Drag the shape called “PC” in to diagram.
Because PROMET@Work does not recognize a “PC” as member of its object base, it opens a dialog for you
to select a class for the object you are trying to insert.
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Figure 32: Inserting an ‘unknown’ physical resource

If you choose PhysResource, PROMET@Work will create a subclass called “PC” and its corresponding
instance under PhysResource. You may now insert more PC’s in your model and they will be recognized as
instances of a physical resource, subclass PC. Physical resources are connected to an activity by the
association “uses phys.resource”.

You may insert the same physical resource more than once into a process using right click insert and check
Show Existing.

You may not insert the same activity call more than once, but you can make multiple calls to the same
activity.

Properties of the physical resource are defined in the Measures tab in the Edit dialog.
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Figure 33: Physical resource dialog — Measures tab

The Measures tab of a physical resource has fields used mainly for simulation purposes. Variable cost
depends on the time the resource is used. Fixed cost is a cost factor per access. Capacity says how often
the physical resource may be used concurrently. Setup Time specifies how long it takes the physical
resource to be set up in seconds.

For physical resources it makes sense to have a class model where you can specify all the types of
resources you use in your model and assign shapes how to display them.

You may decide that you only what to place a picture, no actual object in your model. Then you can click the
button Accept of the System Class dialog only the picture will be inserted.

Analogous to the Measures tab, the Off-time tab is used to enter information needed for a simulation.
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Figure 34: Physical resource dialog — Off-time tab
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Off-time indicates the unavailability time periods of a resource. The user can set each off-time/model. To do
this, first select the off-time in PROMET@Work explorer and open its edit dialog box. Under the Off-time tab
you can change the default values for the selected off-time.
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Figure 35: Off-time — Editing off-time values

The use of off-times makes only sense if you consider 24 hrs working time period for your process.
You may set a 24 hrs working time period under Tools->SemTalk Options>Extras (Tab)>Hours
per day (options).

3.7 Buffers D

Buffers are systems where information is stored and is available to be read. Like in the case of physical
resources, a general buffer shape can be found in the “Activity Chain” stencil, but you may also employ MS
Visio shapes. Refer to the prior section to get more information about using MS Visio shapes in
PROMET@Work.

Buffers are associated to activities through the “read from” and “store to” connectors.
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Figure 36: Inserting a buffer in an activity chain

A buffer has also properties like fixed and variable costs, what kind of information it stores, flush intervals,
etc. Like in the cases before, these properties are edited in the “Measures” tab of the Edit dialog.

t Buffer: ERP system |Z||E|[g|

General | Attributes | Aszociations

Root Class | output v|
Class: | v|
Variable Cost | |

Fised Cost | |

Flush Levet N |

Draps Hrs. Mir. Sec.
NN

Fluzh Interval:

ooz
Initial Conterts; I:I

4

I ok, H Eancel]

Figure 37: Buffer - Measures tab

In the Fixed Cost and Variable Cost fields you can enter the related costs with this buffer.

Flush Level / Flush Interval determines if the buffer empties automatically and how. If the values are set to
nil “0”, then the buffer has no automatic flush.
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Initial Contents describe the size of the stored content at instantiation time.

The associations “read from” and “store to” have also properties (e.g. fixed costs, number of information
objects that flow at once, what kind of objects, efc).

= read from: read from. 3046 |Z||E|fz|

General
Cuanity [ &
oot Class | autput il |
Class:
Fixed Cost:
M store to: store to.3045 |"_||'E”g|
@ Remove O Capy

General

Root Class | autput L¥ |
Clazs: | w |
) Always O Info dependend

Figure 38: Store to/Read from - Measures tab

In the Fixed Cost field you can enter the cost to store/to read to/from a buffer.

For the “store to” association you can determine when information is saved in the buffer by choosing
between Always and Info dependent.

For the “read from” association you can determine if the information is copied or if it is read and then erased
from the buffer by choosing between Copy and Remove.

Finally, an activity chain diagram could like this:
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Figure 39: Complete activity chain diagram

If it is necessary you may refine an activity in a new activity chain diagram.

At this point you have completed this tutorial. Further documentation on PROMET@work and
complementing functionalities can be found at www.promet-web.com or www.semtalk.com/manuals.htm.
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